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DISCLAIMER 

The information contained herein is the property of FlightSafety Simulation.  It may not 
be copied in any manner, or disclosed to others, except as expressly authorized. 

This document describes general functionality and does not contain technical data that 
may be restricted for export under the Export Administration Regulations (EAR). 

Every attempt has been made to ensure the information contained herein is valid and 
accurate at the time of publication.  FlightSafety however, reserves the right to make 
changes, corrections and/or improvements at any time and without notice.  In addition, 
FlightSafety disclaims any and all liability for damages incurred directly or indirectly as a 
result of errors, omissions or discrepancies. 

All graphics, illustrations, tables and descriptions are typical and subject to change 
based on customer requirements and availability. 

 

 



 FlightSafety Simulation 

Graphical Interface Systems Group 

GeoChart Editor User’s Guide 

 

 

Copyright © 2014.  FlightSafety International Inc.  The information contained herein is the property of FlightSafety 
Simulation.  It may not be copied in any manner, or disclosed to others, except as expressly authorized. 

 Revision 2.4.4.3 (141008) 3 DIGITAL APPROVAL 

 

 

Contents 
Introduction ..................................................................................................................... 5 

Maintaining your chart set ............................................................................................ 5 

Radio Database .............................................................................................................. 6 

GeoChart Editor controls ................................................................................................. 7 

Area controls ............................................................................................................... 7 

Chart List controls ........................................................................................................ 8 

Chart Details ................................................................................................................ 9 

Undo ........................................................................................................................ 9 

Georeference Method .............................................................................................. 9 

Map Rotation Angle ................................................................................................ 10 

Mouse Pointer position .............................................................................................. 11 

Zoom ......................................................................................................................... 12 

How To .......................................................................................................................... 13 

How to find the charts you need ................................................................................ 13 

How to create a new area .......................................................................................... 14 

How to create a new chart ......................................................................................... 15 

How to organize the chart project .............................................................................. 16 

How to rename an area in the area list ...................................................................... 18 

How to reorder the area list or delete items from the area list ................................... 18 

How to rename a chart in the chart list ...................................................................... 20 

How to reorder the chart list or move a chart up or down in the chart list or delete a 
chart from the chart list .............................................................................................. 21 

How to determine which georeferencing method to use ............................................ 22 

How to georeference a chart with the two points method .......................................... 26 

How to georeference a chart with the one point + scale line method ......................... 27 

How to georeference a chart with the one point + circle method ............................... 28 



 FlightSafety Simulation 

Graphical Interface Systems Group 

GeoChart Editor User’s Guide 

 

 

Copyright © 2014.  FlightSafety International Inc.  The information contained herein is the property of FlightSafety 
Simulation.  It may not be copied in any manner, or disclosed to others, except as expressly authorized. 

 Revision 2.4.4.3 (141008) 4 DIGITAL APPROVAL 

 

How to determine if georeferencing is embedded in the chart ................................... 29 

How to convert an old ChartInfo.xml file to the new format ........................................ 29 

Types of reference points .............................................................................................. 30 

Georeference point .................................................................................................... 30 

Scale line endpoint .................................................................................................... 33 

Reference circle point ................................................................................................ 35 

Map boundary point ................................................................................................... 36 

Audit function. ............................................................................................................... 38 

Purpose ..................................................................................................................... 38 

Running an audit........................................................................................................ 38 

Refresh Idents function ................................................................................................. 40 

Purpose ..................................................................................................................... 40 

Refreshing nav aid idents .......................................................................................... 40 

Glossary ........................................................................................................................ 43 

 



 FlightSafety Simulation 

Graphical Interface Systems Group 

GeoChart Editor User’s Guide 

 

 

Copyright © 2014.  FlightSafety International Inc.  The information contained herein is the property of FlightSafety 
Simulation.  It may not be copied in any manner, or disclosed to others, except as expressly authorized. 

 Revision 2.4.4.3 (141008) 5 DIGITAL APPROVAL 

 

Introduction 

GeoChart Editor is used to georeference and to organize flip charts, approach plates, 
sectionals, navigation charts, and even hand drawn maps so they can be used with 
FlightSafety International’s GeoChart mapping products.  It works with PDF and TIFF 
files which when properly georeferenced, can be drawn with the aircraft and aircraft 
track on the charts during training and debrief sessions. 

Many types of charts can be acquired from the Federal Aviation Administration (FAA) 
Digital Charting Products web site.  Charts are delivered as GeoTIFF files contain 
embedded georeference information and only need to be added into the GeoChart 
project and given a name.  Other TIFF or PDF files without embedded georeference 
information can be georeferenced with the GeoChart Editor and used with supported 
FlightSafety International IOS and SimVu products. 

The GeoChart Editor makes it easy to georeference just about any map that is drawn to 
scale.  GeoChart Editor can even use a FlightSafety Radio Database to find the location 
of an NDB, TACAN, VOR/DME, waypoint, or other navigation aid. 

Maintaining your chart set 

This user’s guide will help you use the GeoChart Editor to configure and maintain the 
chart sets for your training scenarios.  Because each site is different, with different roles, 
configuration management requirements, and procedures; each site should determine 
their own specific procedures for maintaining their GeoCharts chart set.  A few 
guidelines are provided here. 

 

For simulators that support GeoCharts, a chart set is provided on a GeoChart 
installation CD and installed on the SFS server in \\SFS\SIMDATA\Data\GeoCharts.    
Because of their location and low screen resolution, the IOS PCs and SFS server are 
not well suited for the GeoChart Editor.  A separate workstation with a large, high 
resolution monitor will work best.   

The entire contents of the GeoChart Data CD can be copied into a working directory on 
the workstation.  The chart set can then be updated in that working directory.  When the 
new chart set is ready, create a new GeoCharts data CD from the files in the working 
directory and install the new GeoCharts data CD onto the trainer.   

Tip: The more charts you have in your chart set, the more charts you will 
need to update as new ones are published.  Only keep the charts you use 
in your chart set.   
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Radio Database 

The GeoChart Editor can use a FlightSafety Radio Database to look up the location of 
known navigation aids (nav aids) that are commonly identified on charts.  A Radio 
Database is not required for georeferencing charts but it does make identifying known 
reference points much easier.  When the GeoChart editor uses a Radio Database, you 
can enter the ICAO station identifier for known nav aids instead of typing the latitude 
and longitude for a reference point.  Radio Databases do not contain all known nav aids 
but the Radio Database that is installed on your trainer will contain most of the nav aids 
that you will need.  For best results, use the same radio database that will be used on 
the trainer where the GeoChart project is to be installed.   

To open a radio database, select File -> Open Radio Database from the application 
menu.  Browse for the radio database .bin file.  This is usually installed in the 
\\SFS\simdata\data\rdb directory on the simulator and is named fsi_rdb.bin.  After you 
have opened a radio database, GeoChart Editor will remember the file and will reopen 
the radio database next time the GeoChart Editor starts. 

If a radio database is open, the radio database name will be shown in the status bar at 
the bottom of the window, see Figure 1. 

 

 

Figure 1 Field showing an open radio database 
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GeoChart Editor controls 

Area controls 

 

The Area list shows all of the areas 
that are included in the GeoChart 
chart set.  Click the drop-down 
button to display a scrollable list of the areas that exist in your chart set and select a 
new area to display. 

Use the Add Area button to show the 
Add Area dialog and create a new area. 

 

 

 

 

 

 

 

 

 

 

Use the Edit Areas button to rename, 
delete, or reorder areas in the area list. 
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Chart List controls 

 

The Chart field shows the current 
selected chart within the current 
selected area.  Use the drop-down button to show a scrollable list of charts within the 
selected area and choose a different chart to edit.  The chart list controls are very 
similar to the area list controls. 

Use the Add Chart button to display an 
Add Chart dialog that will let you name 
the new area and select the position for 
the new area to be added.   

 

 

 

 

 

 

 

 

 

Use the Edit Charts button to rename, 
delete, or reorder charts within the chart 
list. 
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Chart Details 

 

Figure 2 Chart Details Common Controls 

 

The controls in the Chart Details section will vary somewhat depending on the 
georeference method that is selected for a chart. Figure 2 shows the chart detail 
controls that are every chart has. 

The File field shows the filename of the chart file, relative to the location of the 
GeoChart project file.  When a new chart is created, the File field will be blank.  To 
change the file associated with the selected chart, click the Browse… button.  A file 
dialog box will appear, allowing you to choose a .PDF or .TIF file for this chart. 

Undo 

Undo rolls all of the changes you made to the selected chart back to the point when that 
chart was selected.  When you select a different chart, the undo buffer is cleaned out 
and the initial state of the newly selected chart is saved in the undo buffer.  You can 
undo all changes to a chart until you select a different chart. 

Georeference Method 

The radio buttons in the Georeference Method section let you choose the best 
georeferencing method for the chart.   

 

 None is selected when the chart record is first created.  Use none for files that do 
not show maps, such as Alternate Minimums and Take-off minimums. 

 Two Points is the preferred method if you must manually georeference the chart.  
The two points method lets you enter two known points on the map.  Usually, you 
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will only need to enter the idents of two navigation aids that are drawn on the 
map.  The latitude and longitude can be entered manually if the reference point is 
not a navigation aid or if the nav aid ident is not found in the radio database. 

 One Point + Scale Line is used when you have one known reference point and 
the distance between two points on the map is indicated somewhere. 

 One Point + Circle is used when you have one known reference point and a 
reference circle is drawn on the map. 

 Embedded is automatically selected when a TIF file has embedded 
georeference information.  It is disabled if the chart filed does not contain 
embedded georeference information.  If Embedded is selected, the other 
georeference type radio buttons will be disabled.  You cannot manually select or 
unselect the embedded georeference method. 

Map Rotation Angle 

 

Figure 3 Map Rotation Angle 

Most maps are oriented so that true north is up.  For these, the Map Rotation Angle field 
should contain 0.00. 

If north is to the left, Map Rotation Angle is -90°. 

If north is to the right, Map Rotation Angle is 90°. 

If it is somewhere in between, estimate the angle then use the mouse pointer and the 
latitude/longitude field in the lower, right corner of the GeoChart Editor window to verify 
that georeferencing is correct.  Adjust the map rotation angle as needed until it is correct 
for several points on the map.  A plastic protractor is helpful with this. 

If you are using the two point georeferencing method, the map rotation angle will be 
calculated automatically.  When GeoChart editor calculates a new map rotation angle, 
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the map rotation angle field will be highlighted briefly to alert you that the value has 
changed.  You can use the calculated map rotation angle to help verify the accuracy of 
the georeferencing for that chart.   

 

Map Boundaries 

 

Map boundary points identify the edges of the map.  This is used by some GeoChart 
tools to identify which charts cover a given point in the world.  By default, GeoChart 
Editor will set the boundary points at each corner of the document.  That usually 
includes some blank space at the edges of the document.  If you want to mark the 
edges of the map, select the NW, NE, SE, and SW radio buttons in turn and right click 
on the map to set the respective boundary point position.  You do not need to keep the 
boundary points in order, GeoChart Editor will do that for you. 

   

X/Y Adjust 

Use the X/Y Adjust buttons to fine-tune the position of the selected point. 

 

The up, down, left, and right buttons will each move the reference point one pixel.  This 
can be easier than trying to hit a single pixel with the mouse. 

Mouse Pointer position 

The mouse pointer position is shown in the GeoChart Editor’s status bar.  See Figure 4. 
The X,Y pixel position will always be shown.  If the chart is georeferenced, the latitude 
and longitude are shown and are updated as you move the mouse around the map. If 
the latitude and longitude do not update as you move the mouse pointer, the chart is not 
georeferenced. 
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The X,Y and latitude/longitude mouse positions can be used to check whether or not 
georeferencing is good on the chart.  Keep in mind that one pixel could represent 
several hundred feet which can be more than two seconds latitude or longitude. 

 

Figure 4 Latitude and Longitude shown for the mouse pointer 

 

 

Zoom 

To zoom in or out on a point on the map, click the mouse on the map, place the mouse 
pointer over the point of interest then roll the mouse wheel up to zoom in or down to 
zoom out on that point. 
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How To 

How to find the charts you need 

The following charts are available from http://aeronav.faa.gov. 

 Terminal Procedure Publication (TPP) charts for many civilian airfields (PDF 
format) 

 IFR Enroute charts for North America (GeoTIFF and PDF format) 

 VFR Terminal Area Raster Charts (GeoTIFF format) 

For charts that cover large areas, such as sectional charts and enroute charts, the map 
projection used to create the chart is important.  These large charts are usually 
available in GeoTIFF format which contain the map’s projection information.  It is best to 
use GeoTIFF files if they are available, doing so will save you some work.  For charts 
that cover a relatively small area, such as TPP and VFR terminal area raster charts, we 
can georeference the chart using some fairly simple methods that are described in this 
user’s guide.   

In order to georeference a chart that covers a smaller area (100 miles or less) you need 
to know the orientation of the map and at least two known reference points or one 
known reference point and the scale.  The orientation of the map is usually such that up 
is north.  If the map is rotated, that rotation angle will also be needed.  One or more 
known points will need to be identified on the map by latitude and longitude or by a 
navigation aid identifier.  If two known points cannot be identified on the map, the map 
scale can be provided with the distance between two points or with three points along 
the perimeter of a reference circle. 

Most of the FAA’s TPP charts are drawn to scale but there are some exceptions.  It 
would be good to review the FAA Aeronautical Chart User’s Guide, available on the 
FAA Web site.  The FAA Aeronautical Chart User’s Guide will tell you what parts of a 
chart are drawn to scale and what parts are not.  This will help you to correctly 
georeference a chart.  If you use a reference point located in a not-to-scale area of the 
map, none of the map will be properly georeferenced. Some charts are not drawn to 
scale at all, in that case, just do your best. 

A hand drawn map can be geo-referenced if it is drawn to scale.  Scan the chart and 
save it as a PDF or TIFF file then copy the image file into your GeoChart project 
directory.  Georeference it as you would for any other chart. 

http://aeronav.faa.gov/
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How to create a new area 

 

1. Click the Add Area button on the GeoChart editor window.  The Add Area dialog 
will be displayed. 

 

2. When the Add Area dialog first appears, a new area named “NEW AREA” will be 
shown in the edit field and the area that you had selected will be highlighted in 
the list.  In the edit field, type to replace “NEW AREA” with the name of the area 
you want to add. 

3. Select the position for the new area using the scrollable list and the Insert At 
options.   

 Front will add your new area to the top of the area list.   

 Before will insert the new area before the one selected in the list.   

 After will insert the new area after the one selected in the list.   

 End will insert the new area at the end of the list. 

4. Press OK to add the new area.  The Add Area dialog will be dismissed and the 
new area will be created with a blank chart record called “NEW CHART.” 

5. Back in the editor window, press the Browse… button to browse to the location of 
chart file. 
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6. Navigate to the chart file, select the file, and press Open. 

7. The Browse dialog will be dismissed, the filename will be shown in the File field, 
and the chart will be displayed in the chart portion of the GeoChart Editor. 

8. If the chart file is not a GeoTiff file, the new chart will initially have “None” as the 
georeference method.  Look at the chart to determine what georeferencing 
method will work best and select the georeference method from the 
Georeference Method radio buttons.  Georeferencing techniques will be 
described in detail later.  If the chart is a GeoTIFF file, the chart editor will detect 
the embedded georeferencing information and will automatically select 
“Embedded” as the georeference method. 

9. See “How to rename a chart in the chart list” for instructions on renaming the 
new chart.  

How to create a new chart 

To add a new chart: 

1. Click the Add Chart button on the GeoChart editor window.  The Add Chart 
dialog will be displayed. 

 

2. When the Add Chart dialog first appears, a new chart named “NEW CHART” will 
be shown in the edit field and the chart that you had previously selected will be 
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highlighted in the list.  In the edit field, type to replace “NEW CHART” with a 
meaningful name. 

3. Select the position for the new chart using the scrollable list and the Insert At 
options.   

 Front will add your new chart to the top of the chart list.   

 Before will insert the new chart before the one selected in the list.   

 After will insert the new chart after the one selected in the list.   

 End will insert the new chart at the end of the list. 

4. Click OK to finish adding the new chart or click Cancel if you change your mind 
and do not wish to add the new chart. 

If the chart file is a GeoTIFF file, Embedded will be the georeferencing method and all 
other georeferencing methods will be disabled. 

If the chart file is not a GeoTIFF file the georeference method will initially be None.  
Review the chart to determine the best method for georeferencing the chart. 

How to organize the chart project 

The GeoChart project is organized by area and chart name.  There can be any number 
of areas in the GeoChart project.  Within each area there are one or more charts.   

The location of each individual chart file is determined relative to the location of the 
GeoChart project file.  So, if the ChartInfo.xml project file is in C:\MyCharts, all of the 
chart files need to be in the C:\MyCharts directory or a directory within C:\MyCharts.  It 
would be a good idea to place all of the chart files for one area in their own directory as 
shown in Figure 5.   
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Figure 5 Suggested chart project directory structure 

 

If you get updates for your charts on a subscription CD, your directory structure and file 
names should be the same as they are delivered on the CD.  This will let you update the 
charts by simply dragging and dropping the entire directory structure into your GeoChart 
project directory and running the GeoChart audit to review the updates.  Otherwise, you 
will need to remember where you copied each chart.  If your chart subscription contains 
more charts than you use, you do not need to include all of those charts in your 
GeoChart project.  You can include only the charts you need and ignore the rest. 

With the directory structure shown in Figure 5 a recommended structure for the 
GeoChart project would be to have 3 areas: KBUR, KCLT, and KLGB.  Each area would 
contain charts for each file in its respective directory. 

If a file is renamed or moved to a different directory or if the directory is renamed, you 
will need to update the file field for each affected chart. 

Some of the GeoChart plugins for IOSnt will automatically search for a chart based on 
the current airport and runway.  These products require the area to be named after the 
ICAO identifier for the airfield.  For FAA Terminal Procedure Publications (TPP) usually 
the chart name should follow the name at the top of the chart.  Using a different naming 
scheme for the areas or charts may break the automatic chart selection features in the 
IOS. 

If you wish to include sectionals or other charts that cover a large area, you can name 
the area or areas anything that will be meaningful to the instructors and will help them 
find the charts.  You may also want to add the sectional chart to each of the 
areas/airfields that the chart covers. 
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How to rename an area in the area list 

 

1. Press Edit Areas.  

 

The Edit Area List dialog will appear with the name of the selected area shown in 
the Area name field and highlighted in the list.  If you want to rename a different 
area, select the area that you want to rename. 

2. Type over the name in the edit field.  When you do, the Rename and Undo 
buttons will become active. 

3. Press Rename to finish renaming the area.  The area will be updated in the list.  
Rename and Undo will be disabled. 

4. Before you press Rename, you can press Undo to restore the original area name 
to the Area name field. 

How to reorder the area list or delete items from the area list 

 

To reorder the area list or move an area up or down in the area list or delete an area 
from the area list: 
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1. Press Edit Areas.  

 

The Edit Area List dialog will appear with the name of the selected area shown in 
the Area name field and highlighted in the list. 

2. From the list, select the area that you want to move. 

3. Use the buttons to move or delete the selected area. 

 moves the selected area to the top of the list 

 moves the selected area up one 

 moves the selected area down one  

 moves the selected area to the end of the list 

 deletes the selected area from the list 

4. Press OK to dismiss the Edit Area List dialog. 
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How to rename a chart in the chart list 

 

1. Press Edit Chart.  

 

The Edit Chart List dialog will appear with the name of the selected chart shown 
in the Chart name field and highlighted in the list.  If you want to rename a 
different chart, select the chart that you want to rename. 

2. Type over the name in the edit field.  When you do, the Rename and Undo 
buttons will become active. 

3. Press Rename to finish renaming the chart.  The chart will be updated in the list.  
Rename and Undo will be disabled. 

4. Before you press Rename, you can press Undo to undo the editing changes you 
have made in the Chart name field. 

 

 



 FlightSafety Simulation 

Graphical Interface Systems Group 

GeoChart Editor User’s Guide 

 

 

Copyright © 2014.  FlightSafety International Inc.  The information contained herein is the property of FlightSafety 
Simulation.  It may not be copied in any manner, or disclosed to others, except as expressly authorized. 

 Revision 2.4.4.3 (141008) 21 DIGITAL APPROVAL 

 

How to reorder the chart list or move a chart up or down in the chart list or delete 
a chart from the chart list 

 

1. Press Edit Chart.  

 

The Edit Chart List dialog will appear with the name of the selected chart shown 
in the Chart name field and highlighted in the list. 

2. From the list, select the chart that you want to move. 

3. Use the buttons to move or delete the selected chart. 

 moves the selected chart to the top of the list 

 moves the selected chart up one 

 moves the selected chart down one  

 moves the selected chart to the end of the list 
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 deletes the selected chart from the list 

4. Press OK to dismiss the Edit Chart List dialog. 

How to determine which georeferencing method to use 

It would be good to be familiar with the “AeroNav Products Aeronautical Chart User’s 
Guide” published by the FAA and available for free download from http://www.faa.gov.  
The User’s Guide describes what portions of a chart are and are not drawn to scale.  
This will help in determining if there is enough information on the chart to georeference 
it and which georeferencing method will work best for that chart. 

GeoTIFF files are TIFF files with a .tif extension that contain embedded georeferencing 
information.  This is the best georeferencing method if it is available.  If the chart is a 
GeoTIFF file, the embedded method will be selected automatically and all other 
georeferencing options will be disabled.  Not all TIFF files are GeoTIFF files.  The 
publisher should have information about whether or not they distribute GeoTIFF files or 
you can open the .tif file with GeoChart Editor to see if it contains embedded 
georeference information. 

Besides embedded, two point georeferencing is probably the most straightforward.  If 
there are two navigation aids shown on the chart, it would be easiest to use the two 
point method.  Place the crosshair for each point at the center of the navigation aid 
symbol and look up the location of the nav aid with its 2 to 5 letter identifier by entering it 
into the reference point ident field.   See Figure 6 and Figure 7. 

 

 

Figure 6 VTU  VOR-DME navigation aid 

 

http://www.faa.gov/
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Figure 7 Georeference point for VTU nav aid 

 

Airport diagrams usually have coordinate lines drawn on the map.  That makes it easy 
to identify at least two known reference points.  The latitude and longitude lines are 
usually drawn on the map so the intersection of two lines makes a good reference point, 
see Figure 8.  The map rotation angle will be calculated automatically if you use the two 
point georeferencing method.   

 

Figure 8 Airport Diagram 
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Some charts, such as the one shown in Figure 9, are rotated.  If you use the two point 
georeferencing method, the rotation angle is calculated automatically.  When the 
rotation angle is recalculated it will be highlighted briefly.  For other georeferencing 
methods you will need to determine the map rotation angle yourself. 

 

Figure 9 Map Rotation Angle Automatically Calculated 
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Figure 10 Map Rotation Angle 

 

 

If the chart has a reference circle drawn in the map as in Figure 11, the reference circle 
would be a good georeference method to use.  The reference circle shows the scale of 
the map and has the circle radius drawn along the perimeter of the circle.  GeoChart 
Editor lets you mark three points along the perimeter of the circle and enter the circle 
radius, it then calculates the map scale. 
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Figure 11 Scale reference circle 

 

 

If you only have one known point on the map but you do have the distance between two 
points marked, you can use the One Point + Scale Line method. 

How to georeference a chart with the two points method 

1. Click the Two Points radio button in the Georeference Method section.  The fields 
for Point 1 and Point 2 will be displayed. 

2. To help find the correct nav aid in the radio database, enter an approximate 
latitude and longitude for Point 1.  It should be sufficient if your estimate is within 
about 10 degrees.  For example: Enter N32 W114 if your chart covers part of 
Southern California. (This step is necessary because nav aid identifiers are not 
necessarily unique.  There are not usually two nav aids with the same identifier in 
the same general area though.) 
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3. Enter the 2 to 5 letter identifiers for a navigation aid shown on the chart.  Press 
tab to go to the next field or right click on the nav aid symbol on the map.  The 
latitude and longitude fields should update with the exact position of the nav aid.  
If the latitude and longitude fields turn red, then GeoChart Editor could not find 
that nav aid in the radio database.  Select a different nav aid and repeat steps 2 
and 3.  If none of the nav aids on the map could be found in the radio database, 
you may need to find the latitude and longitude of a known point on the map and 
enter the latitude and longitude manually.  If the latitude and longitude are way 
off, enter an approximate latitude and longitude then go back to the ident field 
and tab out of the ident field again.  If the latitude and longitude are still way off, 
that nav aid is not in the radio database, pick a different reference point or enter 
the latitude and longitude manually. 

4. Use the mouse (right click) or the X/Y adjust buttons to place the point 1 
crosshairs in the center of the nav aid symbol on the map. 

5. After you have found a good georeference point for point 1, enter the ident for the 
second point in the point 2 Ident field.  When you right click on the nav aid 
symbol on the map, or leave the Ident field, the latitude and longitude fields 
should update with the coordinates of the second nav aid.  If latitude and 
longitude are not updated or if they are wrong, then GeoChart Editor could not 
find the nav aid in the radio database.  You will need to use a different nav aid or 
manually enter the latitude and longitude of a known reference point. 

6. Use the mouse (right click) or the X/Y adjust buttons to place the point 2 
crosshairs in the center of the nav aid symbol on the map. 

When you have successfully georeferenced the chart, the map boundary point 
locations will be updated and the position of the mouse pointer will be updated in the 
lower right corner as you move the mouse across the map.   

To check the georeferencing, place the mouse pointer over the Point 1 and Point 2 
crosshairs and check the calculated latitude/longitude of the mouse pointer against 
what is shown in the Point 1 and Point 2 fields.   

How to georeference a chart with the one point + scale line method 

1. Click the One Point + Scale Line radio button in the Georeference Method area. 

2. Enter an approximate latitude and longitude for a nav aid in the georeference 
point’s Ident field.  It should be sufficient if your estimate is within about 10 
degrees.  For example: Enter N32 W114 if your chart covers part of Southern 
California. 

3. Enter the 2 to 5 letter identifiers for a navigation aid shown on the chart.  Press 
tab to go to the next field or right click on the nav aid symbol on the map.  The 
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latitude and longitude fields should update with the exact position of the nav aid.  
If the latitude and longitude fields do not update, GeoChart Editor could not find 
that nav aid in the radio database.  You will need to repeat steps 2 and 3. 

4. If you have not already done so, use the mouse (right click) or the X/Y Adjust 
buttons to position the violet Georef Point crosshairs over the center of the nav 
aid symbol on the map. 

5. Click the Point 1 radio button 

6. Right click the mouse over the starting point of the reference line.  Use the X/Y 
adjust controls as needed to finish positioning Point 1.  A red crosshair will be 
drawn over point 1. 

7. Click the Point 2 radio button 

8. Right click the mouse over the end point of the reference line.  Use the X/Y 
adjust controls as needed to finish positioning Point 2.  A red crosshair will be 
drawn over point 2 and a faint line will be drawn from point 1 to point 2. 

9. Enter a reference distance (the distance between point 1 and point 2) in the 
Reference Distance field. 

 

When you have successfully georeferenced the chart, the map boundary point locations 
will be updated and the position of the mouse pointer in the status bar will be updated 
as you move the mouse across the map. 

Note: One nautical mile = about 1 minute of latitude arc.  As you move the mouse up 
and down 1 nautical mile (assuming 0 degree map rotation) the latitude/longitude field in 
the lower right corner should change by 1 minute. 

How to georeference a chart with the one point + circle method 

1. Click the One Point + Circle radio button in the Georeference Method area. 

2. Enter an approximate latitude and longitude for a nav aid in the Georef Point’s 
Ident field.  It should be sufficient if your estimate is within about 10 degrees.  For 
example: Enter N32 W114 if your chart covers part of Southern California. 

3. Enter the 2 to 5 letter identifiers for a navigation aid shown on the chart.  It does 
not need to be the nav aid at the center of the circle but it should be a nav aid 
that is within the drawn to scale area of the map.  Press tab to go to the next field 
or right click on the nav aid symbol on the map.  The latitude and longitude fields 
should update with the exact position of the nav aid.  If the latitude and longitude 
fields do not update, GeoChart Editor could not find that nav aid in the radio 
database.  You will need to repeat steps 2 and 3. 
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4. If you have not already done so, use the mouse (right click) or the X/Y Adjust 
buttons to position the violet georeference point crosshairs over the center of the 
nav aid symbol on the map. 

5. Select the Point 1 radio button. 

6. Right click the mouse over a point along the perimeter of the reference circle. 

7. Select the Point 2 radio button 

8. Right click the mouse over a point along the perimeter of the reference circle, at 
least 1/4 of the way around the circle from point 1. 

9. Select the Point 3 radio button 

10. Right click the mouse over a point along the perimeter of the reference circle, at 
least 1/4 of the way around the circle from point 1 and point 2. 

11. Enter the circle radius in the Circle Radius field.   

 

When you have successfully georeferenced the chart, the map boundary point locations 
will be updated and the position of the mouse pointer will be continuously update in the 
lower right corner as you move the mouse across the map. 

To check the georeferencing, one nautical mile = about 1 minute of latitude arc.  As you 
move the mouse up and down 1 nautical mile (assuming 0 degree map rotation) the 
latitude/longitude field in the lower right corner should change by approximately 1 
minute. 

How to determine if georeferencing is embedded in the chart 

GeoTIFF files are TIFF files that contain embedded georeference data.  You can’t tell 
from the filename whether or not a TIFF file is a GeoTIFF file.  You will need to find out 
from the chart publisher or open the file with a utility, like GeoChart Editor, that reads 
GeoTIFFs. 

How to convert an old ChartInfo.xml file to the new format 

Older versions of GeoCharts used a different file format for the ChartInfo.xml file. 

The old format looks like this: 

<?xml version="1.0" encoding="ascii"?> 

<ChartInfo Version="3"> 

<Area> 

<Name>KABQ</Name> 

<Chart> 

<Name>ILS OR LOC RWY 03</Name> 

<File>00012IL3.pdf</File> 

<GeoReferenceData> 

<GeoPoint> 
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<X>644</X> 

<Y>628</Y> 

<Latitude>35.044331</Latitude> 

<Longitude>-106.618078</Longitude> 

</GeoPoint> 

<GeoPoint> 

<X>365</X> 

<Y>627</Y> 

<Latitude>35.043797</Latitude> 

<Longitude>-106.816314</Longitude> 

</GeoPoint> 

</GeoReferenceData> 

</Chart> 

 

The new format looks like this: 

<?xml version="1.0" encoding="UTF-8"?> 

<ChartInfo Version="3"> 

<Area> 

<Name>KABQ</Name> 

<Chart File="00012IL3.pdf" FileDateTime="2009:12:1:18:27:7:0" GeoReferenceMethod="TwoPoint" 

Name="ILS OR LOC RWY 03"> 

<MapRotationAngledegrees>0</MapRotationAngledegrees> 

<GeoPoint GeoPointType="GeoPoint" Latitude="35.044331" Longitude="-106.618078" X="644" 

Y="628"/> 

<GeoPoint GeoPointType="GeoPoint" Latitude="35.043796999999998" Longitude="-

106.81631400000001" X="365" Y="627"/> 

<GeoPoint GeoPointType="MapBoundary" Latitude="35.40908891787268" Longitude="-

107.07565500358425" X="0" Y="0"/> 

<GeoPoint GeoPointType="MapBoundary" Latitude="35.40908891787268" Longitude="-

106.31255298207884" X="1074" Y="0"/> 

<GeoPoint GeoPointType="MapBoundary" Latitude="34.449262440597899" Longitude="-

107.07565500358425" X="0" Y="1650"/> 

<GeoPoint GeoPointType="MapBoundary" Latitude="34.449262440597899" Longitude="-

106.31255298207884" X="1074" Y="1650"/> 

</Chart> 

... 

 

Note: Older versions of the ChartInfo library will not read the new ChartInfo file format 
and GeoChart Editor will not save to the old ChartInfo format.  It would be best to save 
the old ChartInfo.xml file with a different name or in an archive location before 
performing the conversion. 

The old GeoChart library and editor only supported a two point geo-referencing method 
and did not support non-north oriented charts.   

To convert an old ChartInfo.xml file, open the file in the GeoChart editor and save the 
file.  That’s all there is to it.  All charts will use the two-points georeference method.  You 
can change the georeference method as needed. 

Types of reference points 

Georeference point 

A Georeference point is a point on the map that corresponds to a known location in the 
world.  Georeference points will be used in Two Points, One Point + Scale Line, and in 
One Point + Circle reference methods.  A Georeference point has the X,Y coordinates 
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of the point on the chart and it’s corresponding latitude and longitude in the world.  If 
available, the navigation aid identifier is also included. 

 

 

Figure 12 Georeference point information 

 

On the map, a Geo point is shown as a blue or violet crosshair.  Blue crosshairs 
represent geo reference points without an ident.  Violet crosshairs represent a geo 
reference point with an ident.  When the point is currently selected, it will appear with a 
circle drawn around it ( See Figure 13).  When a point is not currently selected only the 
crosshairs will be shown ( See Figure 14 ). 

 

 

 

Figure 13 Selected georeference point 
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Figure 14 Not selected georeference point 

 

If you have a radio database0 loaded and the reference point is the location of a 
navigation aid, you can enter the nav aid ident in the ident field.  When you move to the 
next field or click on the map, GeoChart Editor will look up the location of that nav aid 
and fill in the latitude and longitude fields.  Sometimes several nav aids have the same 
ident.  In that case GeoChart Editor may choose the wrong one.  Verify that the latitude 
and longitude are in the correct general location.  You can give GeoChart Editor a hint 

by entering an approximate latitude and longitude within about 10°.  Then enter the 

ident.  If the ident is in the radio database, GeoChart Editor will fill in the latitude and 
longitude for that navigation aid.   

When you have found a good reference point, use the mouse to position the reference 
point on the map and right click to place the reference point. 

You will not need to enter the approximate latitude and longitude when you enter the 
nav aid ident for the second reference point.  GeoChart Editor now knows where in the 
world the chart is and will search for the nearest navigation aid with that identifier. 

Often, choosing a geo reference point is simple.  A navigation aid that is within the 
drawn to scale portion of the map should be used.  These may include symbols for a 
TACAN, VOR, waypoint, etc.  If the identifier for that navigation aid is in the FlightSafety 
radio database, the Geo-Chart Editor will look up the location for you.  If a known 
navigation aid is not identified on the chart, you may need to enter the latitude and 
longitude manually.  
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Choosing a reference point is not always easy.  If all you have on the map is an airport 
diagram or a landmark, you may need to look up the location of that point from another 
chart that has already been georeferenced and enter that location information manually.  
Be careful to observe the portions of the map that are not drawn to scale.  Do not use a 
reference point that is not in the “to scale” portion of the map or the georeferencing will 
be inaccurate. 

Scale line endpoint 

If only one known point is drawn on the map but there is some scaled reference line, 
then the One Point + Scale Line georeference method can be used.  In the example 
shown in Figure 15, the COLOB waypoint is a known reference point.  We can use that 
same point as one of the reference line endpoints.  The chart also shows the distance of 
6.3 nautical miles between the CLARC and COLOB waypoints.  .   

To georeference the chart shown below, follow these steps. 

1. Select the georeference method, “One Point + Scale Line.  The Chart information 
view will display the necessary fields. 

2. Select the Point 1 radio button then right click on CLARC position.  That is the 
reference line start point. 

3. Select the Point 2 radio button then right click on the COLOB waypoint.  That is 
the endpoint for the reference line. 

4. Enter reference distance of 6.3 Nautical Miles, as marked on the map, in the 
Reference Distance field. 

5. Enter the ident of the known reference point in the Geo Reference point Ident 
field (in this case “COLOB”) then press the tab key.  If GeoChart Editor can find 
the ident in the radio database the latitude and longitude will be filled in and 
highlighted briefly to indicate that it was changed for you.  Verify that the latitude 
and longitude look correct.  If they don’t look right, enter an approximate location 

within about 10° latitude and longitude then re-enter the ident.  If the ident could 

not be found in the radio database, the ident field and its accompanying latitude 
and longitude fields will be highlighted red. 

6. With the GeoRef Point radio button selected, right click the mouse over the 
COLOB waypoint symbol.  You can use the X/Y Adjust buttons to fine tune the 
position of the selected point on the map. 

The two scale line endpoints marked in Figure 15 the CLARC and COLOB waypoint 
symbols.  The reference distance of 6.3 is entered in the Reference Distance field 
shown with the arrow. 
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Figure 15 One Point + Scale Line georeference method 
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Reference circle point 

Reference circle points are shown on the chart as green crosshairs and are marked 
along the perimeter of the reference circle (see Figure 16). 

 

 

Figure 16 Circle radius points 

 

In the Chart Details section the X,Y coordinates of the three reference circle points are 
shown along with the circle radius.  The circle radius is drawn along the perimeter of the 
reference circle and needs to be entered in the Circle Radius field.  Typically, reference 
circles are drawn with a 10 or 20 NM radius. 
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Figure 17 Reference circle data section 

 

 

Map boundary point 

Map boundary points are used by some GeoChart products to help find which maps in a 
GeoChart project cover a given point in the world.  Map boundary points are drawn on 
the map as yellow crosshairs.  There will be 4 map boundary points for each chart to 
mark the four corners of the map. 

 

Figure 18 A map boundary point 

 

The data for the map boundary points is shown at the bottom of the Chart Details 
section. 
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Figure 19 Map Boundaries section 

GeoChart Editor calculates where each point is in relation to the others so it will 
determine which points are at NW, NE, SE, and SW corners of the map.  You do not 
need to keep the map boundary points in order. 
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Audit function. 

Purpose 

GeoChart Editor has a built-in audit function that scans each chart in the open chart 
project file and evaluates the georeferencing information to determine if it is complete 
and up-to-date.  It provides an easy way to see if you might have missed anything or to 
identify chart files that are newer than their georeferencing data. 

An audit record will be generated when any of the following conditions are met: 

 The chart file is newer than the georeferencing information.  This is helpful when 
you get updated chart files from the FAA.  Often, the map on the chart will be 
exactly the same.  In that case it just needs to be reviewed in the GeoChart 
Editor to make sure the reference points still line up with those drawn on the 
chart. 

 The chart file is missing. 

 The chart is missing scale information. 

 The chart is missing one or more georeference points. 

 The georeference points appear too close on the map to get a reasonably good 
scale.  The points should be located at least an inch apart on the map.  If that is 
not possible, georeferencing will still work but it may not work well. 

 The georeference points appear too far away in the world to get a reasonably 
good scale. This is mainly to identify instances where one of the geo-point 

references is still the default of 0°,0° latitude, longitude. 

When an audit generates an audit record for a chart, the georeference information for 
the chart may still be good and georeferencing may work.  The chart editor has simply 
determined that this chart merits a review. 

Running an audit 

To run an audit on the open chart project, select “Audit chart set” in the Edit menu.  The 
audit will start immediately and the Geo-Chart Audit dialog will be displayed. 
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Figure 20 GeoChart Audit window 

 

The “Audit chart files” button will restart the audit from the beginning. 

The status field below the Audit chart files button shows the current audit status. 

Four audit records are shown on the Geo-Chart Audit dialog at a time.  In each audit 
record the name of the area, the chart name, and a description of the audit finding is 
shown.  An edit button will open the chart so the geo referencing information can be 
reviewed and corrected as needed.  Use the scroll bar to the right of the audit records to 
view the rest of the audit records. 

You can keep the Geo-Chart Audit dialog open while you edit a chart.  Each time you 
open the Geo-Chart Audit dialog, it will run a new audit. 

Note: Some chart files are very large, especially high altitude air route charts and 
sectional charts.  If the chart project has a lot of these, it may take a minute for the audit 
to complete.  When the audit has finished, “Audit complete” will be shown in the audit 
status field. 
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Refresh Idents function 

Purpose 

The Refresh Idents function lets you quickly check and update the location of navigation 
aids against a new radio database.  As you maintain your radio database, you also 
need to update your chart set so the nav aid locations in GeoCharts match those in your 
radio database.  Doing so manually would be time consuming an error prone so the 
GeoChart Editor has an automated refresh function. 

Refreshing nav aid idents 

 

To refresh or check your chart set against a radio database, load the chart set with the 
File -> Open Project menu option then load the new radio database with the File -> 
Open Radio Database menu option. 

A Refresh Idents overlay will be appear as shown in Figure 21 Refresh Idents dialog.  
The Refresh Idents dialog will have a brief description of what will take place when you 
press the Refresh button. 

 

Tip: Before refreshing your chart set, it would be a good idea to save a copy of 
your ChartInfo.xml file according to your site’s configuration management 
procedures. 
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Figure 21 Refresh Idents dialog 

Press Refresh to check and update the nav aid locations in your chart set. 

Press Cancel to dismiss the dialog without refreshing the nav aid locations. 

When you press Refresh, GeoChart Editor will look at each georeference point that has 
a nav aid named and will compare the latitude and longitude for that georeference point 
for the latitude and longitude listed for that nav aid in the radio database.  If there are 
different, the georeference point’s location will be updated and the name of the area and 
chart will be added to the Updated Charts list in the center of the dialog. 

When the refresh is completed, a summary of what was done will be displayed in the 
status area and a list of all of the charts that were updated will be shown in the Updated 
Charts list. 
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Figure 22 Refresh Idents with Updated Charts list 

To review any of the updated charts, select that chart in the Updated Charts list.  The 
chart will be loaded in the background area.  DO NOT DISMISS the Refresh Idents 
dialog until you have reviewed all of the charts that you want to review.  The list will be 
deleted when the Refresh Idents dialog is dismissed. 

Press OK to dismiss the Refresh Idents dialog. 

If you are satisfied with the changes, Save the chart set with the File -> Save  or File -> 
Save As menu option. 
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Glossary 

Area An area is a collection of charts.   

Chart Flip chart, approach plate, TPP, enroute chart, sectional,  

Chart File This is the PDF or TIFF file that has the chart image. 

Chart Set May also be called a GeoChart project.  The chart set contains all 
of the charts that will be used for training on the simulator.  Chart 
sets contain one or more areas.  Areas contain one or more charts. 

GeoChart GeoChart is a line of FlightSafety International products to enhance 
training and debrief by displaying the aircraft position and track on 
georeferenced maps and charts. 

GeoChart editor The GeoChart Editor is used to organize and maintain GeoChart 
projects for use in other FlightSafety products that support 
GeoCharts. 

GeoChart project A GeoChart project is a set of georeferenced charts that consists of 
one project file (usually ChartInfo.xml) and many individual PDF or 
TIFF chart files.  The charts themselves are grouped in areas.  For 
charts that do not have embedded georeferencing data (GeoTIFF), 
georeferencing information is stored in the chart project file. 

Georeferencing Associates locations on the map with locations in the world.  This 
allows FlightSafety International GeoChart products to draw the 
aircraft icon in the correct location on the map. 

GeoTIFF A TIFF file with embedded georeference information.  You cannot 
tell from the file name or extension if a file is a TIFF or a GeoTIFF 
file.  TIFF files have a “.tif” or “.tiff” filename extension.  The 
publisher of the chart will indicate if the file is a GeoTIFF file or not.  
GeoChart Editor will automatically detect embedded georeferencing 
information and select the Embedded geo-referencing method. 

Ident Identifier for an airport or navigation aid.  Supported idents are 2 to 
5 characters long. 
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Nav aid Aircraft navigation aid such as a VOR, VOR/TAC, TACAN, NDB, 
ILS, or waypoint.  Each nav aid has a two to five letter identifier 
(ident).  Nav aid idents are not necessarily unique in the world but 
there is usually only one within a given part of the country. 

Project A chart set. 

TIFF TIFF stands for Tagged Image File Format.  Tiff files can contain 
one or more images and additional information such as 
georeference data.  TIFF files have a .tif or a .tiff file extension. 

TPP Terminal Procedure Publication, also known as flip chart or 
approach plate.  TPPs are available for many airfields from the 
FAA’s Aeronav Digital Products web site. 


